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Getting Started

In order to add new instructional levels to Read Naturally® SE installations, there are

two steps you must perform:

1 Add license codes:  Adding license codes gives teachers and students access to the
new levels (the stories).

2 Copy stories to the server:  With network installations, you copy the stories from
the level CDs to the server's hard drive.  Having the stories on a server enables
students to access the stories from any client workstation that has Student Stories
installed and can access the server.

Note: You do not copy the stories for stand-alone installations.  You insert the level CD
in the computer’s CD/DVD drive to access the stories.

Determining What Version of Read Naturally You Have

If you have a stand-alone installation, follow the instructions in Chapter 4.  If you have
a network installation, you must determine what version of Read Naturally you have so
you know which instructions apply to you.

To determine what version of Read Naturally you have:

1 Double-click the Read Naturally icon to display the Read Naturally login screen.

2 Look up the Read Naturally version number.

� For Windows, choose About Read Naturally from the Help menu.

� For Macintosh, choose About Read Naturally from the Read Naturally SE
menu.

3 Follow the instructions for the version you have:

� For version 2.1 or higher, follow the instructions for SE Network Plus in
Chapter 2.

� For version 2.0.3 or lower, follow the instructions for SE Network in Chapter 3.

For more information about Read Naturally Software Edition, go to the Read Naturally
website:  www.readnaturally.com/support/
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Adding Levels for SE Network Plus  
Installations

The procedures in this chapter explain how to add levels for SE Network Plus

installations (version 2.1 or higher).  See the instructions in Chapter 1 to determine what

version of SE you have.  There are different procedures for Windows servers and Mac

OS X servers.

Adding Levels for Windows Servers

Adding levels is a two-part process—adding the license codes and copying the files to

the server.  

Adding the License Codes

The procedures for adding license codes are different for district servers and school

servers.

To add level license codes Windows district server installation:

1 Start the District Admin Utility.  Open the RNSEServer folder (the default location 

is \Program Files\RNSENetworkPlus\RNSEServer) and double-click

DistrictAdminUtility.exe.  The District Admin Utility window displays.

2 Choose the License Codes tab.

.
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3 Enter the license numbers for the new instructional levels.  These license numbers

must be for network software, not stand-alone software.  Enter each two-part license

number in the boxes provided and click Add License.

4 Assign the instructional levels to the schools by performing these steps:

a Choose the License Distribution tab.

b Choose Edit.

c Select one of the levels.

d Click Add Schools.

e Select the schools to which you want the level assigned.

� To select a group of schools that are listed together, click the first school,

hold down the Shift key, and then click the last school.

� To select multiple schools that are not listed together, hold down the Control

key and then click the schools you want to include.

f Click Add.

g Repeat these steps for the other levels.

5 Click Quit when you are finished.

6 Copy the stories to the server (see "Copying the Stories to the Server" for details).

To add level license codes for a Windows school server installation:

1 Start the Install License utility.  Open the RNSEServer folder (the default location 

is \Program Files\RNSENetworkPlus\RNSEServer) and double-click

InstallLicense.exe.  The Level Registration window displays.
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2 In the Level Registration window, enter the license numbers for the levels you

purchased.  For each license, enter the two-part license number in the boxes and

click Add License.  The licenses are added to the list.

3 Click Done.

4 Copy the stories to the server (see "Copying the Stories to the Server" for details).

Copying the Stories to the Server

Important:  If you are adding sequenced or phonics levels, you do not need to copy the

stories; you only need to enter the license codes.  You only need to need to copy the

stories if you are adding Idioms, American Manners and Customs, or Spanish levels.

To copy stories from the level CDs to a Windows server:

1 Insert the level CD into the CD drive of the server.

2 Double-click the FileCopy.exe icon in the following folder on the server's hard

drive:  C:\Program Files\RNSENetworkPlus\RNSEServer.  (This is the default

location.) The File Copy window displays.

.

3 Copy From:  The file-copy program should automatically locate the folder on the

CD that contains the stories.  If it doesn't, you can click the Browse button and then

locate and select the [CD drive]:\StoryFiles\<level> folder on the CD and click

OK.

4 Copy To:  Do not change the location where the story files are copied.  The story

files must be copied to the default location in the RNSENetworkPlus folder.  If for

some reason this field is blank, click the Browse button, locate and select the

C:\Program Files\RNSENetworkPlus\RNSEServer\ServerFiles\data folder, and

then click OK.  (This is the default location.)

5 Click Copy to start copying the stories to the server.  When the copying is finished,

you will see a "Done" message.
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6 To copy additional stories to the server, insert a new level CD into the CD drive of

the server and repeat the process.

7 Click Exit when you are done copying levels.

Adding Levels for Mac OS X Servers

Adding levels is a two-part process—adding the license codes and copying the files to

the server.  

Adding the License Codes

The procedures for adding license codes are different for district servers and school

servers.

To add level license codes for a Mac OS X district server installation:

1 Start the District Admin Utility.  Open the RNSEServer folder (the default location

is /Applications/RNSENetworkPlus/RNSEServer), and double-click

DistrictAdminUtility.  The District Admin Utility window displays.

2 Choose the License Codes tab.

3 Enter the license numbers for the new instructional levels.  These license numbers

must be for network software, not stand-alone software.  Enter each two-part license

number in the boxes provided and click Add License.

4 Assign the instructional levels to the schools by performing these steps:

a Choose the License Distribution tab.

b Choose Edit.



c Select one of the levels.

d Click Add Schools.

e Select the schools to which you want the level assigned.

� To select a group of schools that are listed together, click the first school,

hold down the Shift key, and then click the last school.

� To select multiple schools that are not listed together, hold down the Control

key and then click the schools you want to include.

f Click Add.

g Repeat these steps for the other levels.

5 Click Quit when you are finished.

6 Copy the stories to the server (see "Copying the Stories to the Server" for details).

To add level license codes for a Mac OS X school server installation:

1 Start the Install License utility.  Open the RNSEServer folder (the default location is

/Applications/RNSENetworkPlus/RNSEServer) and double-click InstallLicense.

The Level Registration window displays.

2 In the Level Registration window, enter the license numbers for the levels you

purchased.  For each license, enter the two-part license number in the boxes and

click Add License.  The licenses are added to the list.

3 After you have added all of your licenses, click Next.  The Installation Complete

screen displays.

4 Click Done.

5 Copy the stories to the server (see "Copying the Stories to the Server" for details).

Copyright © 2008 Read Naturally, Inc. 7 SE Level Installation Guide

Read Naturally Software Edition Adding Levels for SE Network Plus Installations 



Copying the Stories to the Server

Important:  If you are adding sequenced or phonics levels, you do not need to copy the

stories to the server; you only need to enter the license codes.  You only need to need to

copy the stories if you are adding Idioms, American Manners and Customs, or Spanish

levels.

To copy stories from the level CDs to a Mac OS X server:

1 Insert the level CD into the CD drive of the server.  

2 Double-click the FileCopy icon in the following folder on the server's hard drive:

/Applications/RNSENetworkPlus/RNSEServer.  The File Copy window displays.

3 Copy From:  The file-copy program should automatically locate the folder on the

CD that contains the stories.  If it doesn't, you can click the Browse button, locate

and select the /StoryFiles/<level>/ folder on the CD, and click OK.

4 Copy To:  Do not change the location where the story files are copied.  The story

files must be copied to the default location in the RNSENetworkPlus folder.  If 

for some reason this field is blank, click the Browse button, locate and select the

/Applications/RNSENetworkPlus/RNSEServer/ServerFiles/data folder and click

OK.

5 Click Copy to start copying the stories to the server.

6 You will be asked to authenticate.  Enter your network administrator password.

7 When the copying is finished, you will see a "Done" message.

8 To copy additional stories to the server, insert a new level CD into the CD drive of

the server, and repeat the process.

9 Click Exit when you are done copying levels.
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Adding Levels for SE Network 
Installations

The procedures in this chapter explain how to add levels for SE Network installations

(version 2.0.3 or lower).  See the instructions in Chapter 1 to determine what version of

SE you have.  There are different procedures for Windows servers and Mac OS X

servers.

Adding Levels for Windows Servers

Adding levels is a two-part process—adding the license codes and copying the files to

the server.  

Adding License Codes

You can add the license codes from a client workstation or from a server.

To add license codes from a client workstation:

1 Log in to Read Naturally® with the administrator password.  

2 Choose the School tab.

3 From the File menu, choose Register Levels.  The Level Registration window

displays.

3
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4 Enter the license numbers for each level you are adding.  For each license, enter the

two-part license number in the boxes and click Add License.  The licenses are

added to the table.  

5 After you have added all of your licenses, click Next.  The Installation Complete

screen displays.  

6 To add more levels, click Back and repeat steps 4 and 5.  If you are finished adding

levels, click Done.  

7 Copy the stories to the server (see "Copying the Stories to the Server" for details).

To add license codes from the server:

1 Log in to the server.  

2 Browse to the /Program Files/RNSEServer/RNSEServer folder and double-click

InstallLicense.  

3 Follow steps 4 though 7 above.  

Copying the Stories to the Server

To copy stories from the level CDs to the Windows server:

1 Insert the level CD into the CD drive of the server.  

2 Double-click the FileCopy.exe icon in the following folder on the server's hard

drive:  /Program Files/RNSEServer/RNSEServer The File Copy window

displays.

3 Copy From:  The file-copy program should automatically locate the folder on the

CD that contains the stories.  If it doesn't, you can click the Browse button, locate

and select the /StoryFiles/<level>/ folder on the CD, and then click OK.  
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4 Copy To:  In most cases, you should not change the location where the story files

will be copied.  If for some reason you need to change it, you can click the Browse

button and then choose a new location and click OK.  

5 Click Copy to start copying the stories to the server.  

6 When the copying is finished, you will see a "Done" message.  

7 To copy additional stories to the server, insert a new level CD into the CD drive of

the server and repeat the process.  

8 Click Exit when you are done copying levels.  

To manually copy the stories from the level CDs to the Windows server (if you have

problems with the file-copy program):

1 Insert a level CD into the CD drive of the server.  

2 Browse to the /StoryFiles/<level> folder on the CD.  

3 Copy the <level>.vdb file to the /Program Files/RNSEServer/RNSEServer/

Databases folder on the server.  

Adding Levels for Mac OS X Servers

Adding levels is a two-part process—adding the license codes and copying the files to

the server.  

Adding License Codes

You can add the license codes from a client workstation or from a server.

To add license codes from a client workstation:

1 Log in to Read Naturally with the administrator password.  

2 Choose the School tab.

3 From the File menu, choose Register Levels.  The Level Registration window

displays.  
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4 Enter the license numbers for each level you are adding.  For each license, enter the

two-part license number in the boxes and click Add License.  The licenses are

added to the table.  

5 After you have added all of your licenses, click Next.  The Installation Complete

screen displays.  

6 To add more levels, click Back and repeat steps 4 and 5.  If you are finished adding

levels, click Done.  

7 Copy the stories to the server (see "Copying the Stories to the Server" for details).  

To add licenses from the server:

1 Log into the server.  

2 Browse to the /Library/RNSEServer/ folder and double click InstallLicense.  

3 Follow steps 4 though 7 listed above.  

Copying the Stories to the Server

To copy stories from the level CDs to the Mac OS X server:

1 Insert the level CD into the CD drive of the server.  

2 Double-click the FileCopy icon in the following folder on the server's hard drive:

/Library/RNSEServer. The File Copy window displays.



3 Copy From:  The file-copy program should automatically locate the folder on the

CD that contains the stories.  If it doesn't, you can click the Browse button, locate

and select the /StoryFiles/<level>/ folder on the CD, and then click OK.  

4 Copy To:  In most cases, you should not change the location where the story files

will be copied.  If for some reason you need to change it, you can click the Browse

button and then choose a new location and click OK.  

5 Click Copy to start copying the stories to the server.  

6 When the copying is finished, you will see a "Done" message.  

7 To copy additional stories to the server, insert a new level CD into the CD drive of

the server and repeat the process.  

8 Click Exit when you are done copying levels.  

To manually copy the stories from the level CDs to the Mac OS X server (if you

have problems with the file-copy program):

1 Insert a level CD into the CD drive of the server.  

2 When the rnse2cd icon appears on the desktop, double-click it to open it.  

3 Open the StoryFiles folder, and then open the <level> folder.  

4 Copy the <level>.vdb file to the /Library/RNSEServer/Databases folder on the

hard drive of the server.  
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Adding Levels for SE Stand-Alone 
Installations

The procedures in this chapter explain how to add levels for SE Stand-Alone

installations by adding license codes.  There are different procedures for Windows 

and Macintosh computers.  You do not copy the stories for stand-alone installations.  

Adding License Codes for Windows Stand-Alone Installations

To add license codes for a Windows stand-alone installation:

1 Log in to Read Naturally® SE with the administrator password.

2 Choose the School tab.

3 From the File menu, choose Register Levels.  The Level Registration window

displays.

4 Enter the license numbers for the levels you are adding.  For each license, enter the

two-part license number in the boxes, and click Add License.  The licenses are

added to the table.

5 After you have added all of your licenses, click Next.  The Installation Complete

screen displays.

6 To add more levels, click Back and repeat steps 4 and 5.  If you are finished adding

levels, click Done.

4

Copyright © 2008 Read Naturally, Inc. 15 SE Level Installation Guide

Read Naturally Software Edition Adding Levels for SE Stand-Alone Installations



Adding License Codes for Macintosh Stand-Alone

Installations 

To add license codes for a Macintosh stand-alone installation:

1 Log in to Read Naturally SE with the administrator password.

2 Choose the School tab.

3 From the File menu, choose Register Levels.  The Level Registration window

displays.

4 Enter the license numbers for each level you are adding.  For each license, enter the

two-part license number in the boxes, and click Add License.  The licenses are

added to the table.

5 After you have added all of your licenses, click Next.  The Installation Complete

screen displays.

6 To add more levels, click Back and repeat steps 4 and 5.  If you are finished adding

levels, click Done.
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